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1 Introduction  

1.1 General 

This operating manual describes the MultiSens Analyzer software package. It addresses 

customers who are already familiar with the basics of chemical sensing combined with the 

numerical recognition algorithms. 

MultiSens Analyzer is distributed in different versions that include different sets of 

functionalities. Depending on your version functionality described in this manual may not be 

available. 

MultiSens Analyzer is constantly improved. New functionality may be introduced, that is not 

already described in this manual. 

1.2 Installation 

Typically this program is delivered as an executable setup file (setup.exe). Starting setup.exe will 

guide you through a simple set of dialogs to install MultiSens Analyzer on your PC. 

If the installation was carried out successfully, you can continue directly to work with your 

system. A re-start of Windows is not required. 

When you are first running MultiSens Analyzer, you will be prompted with a license dialog. You 

might be asked to provide a license.lic and license.txt file.  

 

Both files are typically provided via Email. Please store both files to your hard disk. MultiSens 

Analyzer will present a file dialog to locate the files. Please note that file dialogs do look different 

depending on Windows version and language.  
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When both files license.lic and license.txt are found the license information is shown. In order to 

proceed, you have to enter the License Key and click checkbox next to òI accept the licenseó.  

 

Special versions of MultiSens Analyzer are distributed on CD-ROM or USB-Stick and require no 

explicit installation via a setup program. These versions may directly be started by clicking on 

MultiSensAnalyzer.exe. Trial versions display the license dialog at every start of the program and 

may run without entering a license key. 
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1.3  Checking for updates 

MultiSens Analyzer is continually improved. We have included a function in MultiSens Analyzer 

which automatically checks for updates, whenever the program is started. Your computer needs 

to be connected to the internet, as this function will fetch information from our servers. 

You can disable this function by selecting Help ð Check for Updates from them menu and 

disabling the option òAutomatically check for updates during program startó. 

Select Help ð Check for Updates at any time to check for updates manually. 

 

If an update has been found you can download and install the update by clicking on the òInstalló 

button. 

1.4 System Requirements 

MultiSens Analyzer will run on a computer with Windows XP, Vista or 7.  

A processor with 1 GHz, 512 MB RAM, and 100 MB free disk space is the minimum 

requirement. For complex data sets faster processors (> 2GHz) and more RAM (2 ð 4 GB) are 

recommended. 
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2 MultiSens Analyzer step by step 

2.1 The first evaluation 

MultiSens Analyzer main purpose is to evaluate measurement data from multi sensor 

instruments. Two different types of evaluations are available in MultiSens Analyzer: Classification 

and Regression (the version MultiSens Analyzer Basic only includes Classification).  

Classification is used to assign measurements to a specific class from a set of classes (e.g. Apple, 

Orange or Banana) while Regression is used to calculate a value that describes a quantifiable 

property (e.g. a concentration) 

Step 1: Creating a new classification: 

From the main menu select File ï New ï Classification. Alternatively you can use the icon bar. 

Through the icon bar you have fast access to the most important menu commands. Click on the leftmost 

icon in the icon bar. A menu pops up. In this menu choose Classification. 

 

 

 

Hint: If the mouse cursor remains over an icon for a few moments without clicking, a short descriptive 

text will appear. 

An evaluation compares several measurements with each other, or with reference data. What 

exactly are reference data? Reference data contain those measurements that were used to build 

the mathematical model that is used as the framework to predict new measurements. It is 

impossible to build a model without reference data. When creating a new evaluation, designating 

reference data (which must already exist at this time!) is the first step. Consequently, the 

corresponding page is automatically activated: 
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Step 2: Introducing reference data: 

Click on the Add button. A new dialog window will appear. MultiSens Analyzer can import data in a 

number of formats. By default the default import settings are activated (which can be defined via the 

Options menu). Depending on the file format a single file may contain several or only a single 

measurement. In this tutorial, we want to open an xml file.Use the drop down list in the lower right 

corner to select XML file, then find the DemoClass.xml file and click Open. Please note, that while 

MultiSens Analyzer is available only in English this dialog will use the language of your windows 

installation and also depends on the version of windows. 

 

Hint: You can repeat this procedure a number of times in order to add further measurements to your 

reference data. You may also import several files in one step. To highlight many files at once, 

either click-drag the mouse to draw a marquee around the desired number of file names, or 

highlight the first file name, then shift-click on the last file name. 
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Finally, the result should look similar to the example shown below. The sequence of samples is of 

no importance. 

 

Each measurement contains the entire response of all sensors to one sample. Obviously, the 

complete response curve contains a lot of redundant information. For many types of pattern 

recognition algorithms, this is problematic and will in any case increase the processing time 

drastically. Hence, it is desirable to greatly reduce the amount of data to be processed. 

This is achieved by extracting certain traits (e.g. the maximum of the response curve) from the 

raw signal. Such traits are called ôfeaturesõ in the MultiSens Analyzer software. The entire set of 

features is called the ôfeature vectorõ. The ôfeature vectorõ comprises a number of values extracted 

from the sensorsõ reaction to one sample. 

An optional step might be to remove noise or other influences with a filter before extracting 

features.  In this short introduction we will not use filters and extract features directly from the 

sensor responses. 
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Step 3: Generating a feature vector: 

Click on the tab labeled Feature vector. This will bring the corresponding page to the foreground.  

 

At this point, the feature vector does not contain any features yet. The logical next step is to first 

select the sensors to use, and to then define the type of feature extraction to apply. It is not 

necessary to use the same type of feature extraction for all sensors. 

Step 4: Choosing the sensors: 

Click Add. You will be presented with a new dialog window with a tree view of all devices in the 

measurements of the evaluation. Click the + sign to expand a node. Selected sensors are represented by 

a lit light bulb next to it. For our example, expand the module óQMB moduleô, and select all QMB 

sensors (Q1-Q8). Clicking on a decive / module will select/deselect all contained sensors. When done, 

click OK: 

 

As discussed above, the next step is the choice of feature extraction method. 

In this step we will define which value will be extracted from the sensorsõ response curves. The 

MultiSens Analyzer software makes a number of different options available to you which we will 

discuss in more detail later. For the time being, let us just use one of the simple methods, i.e. we 

will just extract the curvesõ peak values. The corresponding feature extraction method is called 

Sig-Base (shorthand for òsignal minus baselineó). 
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Step 5: Choosing the feature extraction method: 

In the list select Sig-Base and confirm your choice by clicking OK: 

 

This will add eight entries to the list of features, i.e. one feature called Sig-Base for each sensor. 

 

Hint: The composition of a feature vector can be chosen very liberally. It is possible to choose only one 

type of sensor or even one single sensor only. Identical or different features from one sensor can 

be present several times in one feature vector. Obviously, the influence of one particular sensor on 

the final result increases with its number of appearances in the feature vector. 

By now, we have defined what measurements to evaluate and how to extract one value (feature) 

from every QMB sensor in the measurement. Now we will select the right parameters for the 

evaluation. Click on the Projection tab in the parameter window. 
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Step 6: Set the number of components: 

On the Parameter tab set the number of Components to 3. 

All other parameters should be left at their preset default value for the time being. The parameter 

Components determines how many principal components are calculated during the evaluation.  

Before we actually perform the evaluation, let us elaborate a bit more just how the MultiSens 

Analyzer implements the evaluation. In this version of the MultiSens Analyzer, Principal 

Component Analysis (PCA) is built in as the standard processing algorithm. 

Maybe surprisingly, there is no explicit command to launch the evaluation. MultiSens Analyzer 

will automatically recognize which actions are required to achieve what you mean to achieve. 

Hence, to have the evaluation executed, all you have to do is to request the display of the results 

of the PCA. The program will notice that the principal components have not yet been 

determined, and will automatically launch the required algorithms. All final and intermediate 

results will be stored in memory. This will make recalculation a lot faster because the results from 

a previous calculation may be re-used. 

The scores plot is by far the most popular type of display for the results of a PCA. The scores 

plot shows the different samples with respect to two principal components (normally, the first 

and second PCs are shown). Similar samples turn out to be close to each other. Different samples 

lie further apart. 

Step 7: Showing the scores plot: 

From the menu, select Evaluation ï Scores plot, or click the corresponding icon. 

The program will now create a new window to contain the scores plot. Since the data have not 

been yet calculated, this is going to take place now. The first step is the extraction of features 

from the measurements. Once this has been completed, the principal component analysis proper 

will be performed. On a decently fast computer, the whole procedure will only take a few 

seconds. 
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The result should be similar to the example shown next: 

 

The resulting scores plot shows several groups of measurements. We could identify the individual 

samples by printing their measurement names next to them (Graph ð Label ð Measurement), 

however a better way is to assign the measurements to specific classes.  While this information is 

not used in a PCA to calculate the model, the graph will identify measurements belonging to 

different classes with different colors.  

Step 8: Assigning classes to measurements: 

Go back to the Reference data tab and click on the button ñSam.->Classò. This will copy the sample 

information the class for all measurements. 
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The scores plot will automatically reflect the changes. The different classes are indicated by 

different colors and by special ellipses drawn around the measurements belonging to one class. 

The class names are drawn next to the ellipses.  

Finally we need to save the evaluation. 

Step 9: Saving the evaluation: 

From the menu, select File ï Save as. Like in the previous examples of saving files, select the directory 

that you wish to save the evaluation file to, enter a descriptive name, and click Save. 

This concludes the creation of your first evaluation. 

2.2 Importing your data 

MultiSens Analyzer includes import functionality for a number of different file formats. 

Whenever you add measurement data to an evaluation you may choose in the file open dialog 

between the various import formats. Please refer to the appendix for more information in the 

various input formats. 

A typical format that is often used for measurement data is text data (ASCII). However it is 

necessary, to define in detail how the text data within the file is structured. MultiSens Analyzer 

includes some import functions that read will typical text files that we came across (see 

appendix). More often you will need to define how to read your text data files. This can be done 

via selecting Options ð Default Import Settings in the menu. This will bring up following 

dialog: 
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Enter the extension of the data files that you want to import into the field File Extension.  

 

Description may contain a short description for the data file. You could enter the name or type 

of the instrument that generates the data files that you want to import. The content of this field is 

shown in file open dialogs. 

 

Many data files contain a header that cannot easily be imported. By setting the value of Number 

of lines to ignore you can skip these lines during import. 

 

Separators define how individual values are separated. Enter any characters into List  to set them 

as separators. Additionally Tab and Space may be activated as separators. If Ignore 

consecutive separators is activated a new value will only be generated, if a non separator 
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character is read from the text file. If Ignore consecutive separators is not activated, every 

separator will create a new value, that may be empty. 

 

The Decimal Separator discriminates the integral from the fractional part in a numeral value. 

Either a point "."  or comma ","  may be chosen. If set to Automatic the first comma or point, 

found in the numeral value, will be taken as decimal separator. Thousands separators are not 

supported! 

 

Device Name lets you set the name of the device that is used to generate the data. 

 

Parameters is a list of arbitrary parameters that you can add to the import. These are fixed value 

parameters (all imported files will have the same values (entered in this dialog). 

 

The measurement data in the text file is expected to have the form of a two dimensional array. 

The format is defined under Data: 

If Rows contain measurements is checked, then each row in the data array contains an 

independent measurement. For each sensor/device only one measurement point is included in 

the file. If Rows contain measurements is not checked, then only one measurement is included 

in the file, but for each sensor/device a complete response curve may be included. 

The input grid Columns contains the definitions for the column of the data matrix in the text 

file. The number of columns in this grid must match the number of columns in the text file. 

For each column we have to assign a Name and optionally a Type/Unit . 

Action defines what to do with the data in the column. Following actions are available: 

Action  Description  Format 

Value  Sets the Value of the sensor/device.  Decimal number 

Measurement  Sets the name of the measurement.  String 

Ignore  Ignores the column.  - 

DateTime  Sets date and time of the measurement.  Date and time according to 

Windows language settings 

Date  Sets date of the measurement.  Date according to Windows 

language settings 

Time  Sets time of the measurement.  Time according to Windows 

language settings 

Year  Sets the year of the measurement.  number 

Month  Sets the month of the measurement.  1 .. 12 
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Day  Sets the day of the measurement.  1 .. 31 

Hour  Sets the hour of the measurement.  0 .. 23 

Minute  Sets the minute of the measurement.  0 .. 59 

Second  Sets the second of the measurement.  0 .. 59 

Sample  Sets the name of the sample.  String 

Parameter  Sets the content of a parameter.  String 

Float 

Parameter  

Sets the content of a parameter.  decimal number 

Integer 

Parameter  

Sets the content of a parameter.  number 

Class  Sets the class that the measurement is assigned 

to  

String 

Target Value  Sets the target value that the measurement is 

assigned to.  

Decimal number 
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3 Detailed description 

3.1 The concept of the MultiSens Analyzer software 

MultiSens Analyzer allows performing of many different analysis methods. Despite this multitude 

of functions we have focused on an easy usability. All data of an evaluation is stored altogether in 

a single file. Several evaluation files can be kept open and active simultaneously.  

The evaluation files are stored in a well defined XML format.  

 

3.1.1 The most important command: File - New 

Since MultiSens Analyzer uses a file based concept, new evaluations are created via the command 

to create a new file. This command can be reached in two ways: 

  

First, by selecting the New submenu from the File menu (e.g. by pressing Alt-F followed by N),  

 

and second, by selecting the first symbol from the left in the icon bar. 

 

In either case you can select different evaluation types. 

3.1.2 Files and windows within MultiSens Analyzer 

There are several possibilities to represent the contents of a file in MultiSens Analyzer and to 

have several views of one file on the screen simultaneously in different windows. To close all 
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windows belonging to one file, select Close from the File menu. If you have previously made 

any changes to the contents of the respective file, MultiSens Analyzer will prompt you to confirm 

whether you wish to save these changes. If you reply "No", your changes will be lost. If you close 

one of several open windows pertaining to the same file, only the closing of the last remaining 

window will invoke the prompt dialogue. 

 

MultiSens Analyzer is a multiple document application. This means that you can keep several files 

opened simultaneously. For example, you may want to have two different evaluations on the 

screen at the same time, making direct comparison easy. At any point, you may simply open the 

respective file without having to close what you are currently doing. However, this possibility 

should be used sparingly; there is a very real danger of cluttering the screen with dozens of open 

windows. Also, a decent monitor size (17 or more inches) is preferable for use with MultiSens 

Analyzer. 

The Window menu lets you change between windows, and provides several possibilities for 

arranging windows on the screen (e.g. Cascade, Tile horziontal, or Tile vertical). 

 

The example above shows an open evaluation with some corresponding windows.  

 

The content of the menu line depends on the currently active window. Most menu commands 

refer directly to the active window and its file. The title bar of the active window is shown in a 

different color. 
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It is possible for the menu line to change its contents when you change from one window to 

another one (the same is true for the icon bar). In addition, some commands depend on the 

contents and state of a file. 

 

3.2 The evaluation 

An evaluation is used to compare measurements with each other, and/or to classify new 

measurements according to previously recorded measurements. 

Creating a new evaluation is achieved by creating a new file: File ð New ð Classification (or 

Regression). Instead of always starting from scratch you may also choose to load an existing 

evaluation, modify it, and save it under a different name.  

3.2.1 The basic procedure 

MultiSens Analyzer has a number of different analysis methods built in. These analysis methods 

are grouped into two main evaluation types.  

A Classification is used to assign unknown measurements to a set of classes. A Regression is 

used to predict quantitative data, i.e. a value gets assigned to an unknown measurement. The 

choice between Classification and Regression is thus based on the type of result that you want 

to achieve (qualitative vs. quantitative). 

Within each evaluation type there will be a number of different algorithms that you can use to 

perform the analysis. Principal Component Analysis (PCA) and Principal Component Regression 

(PCR) are two standard algorithms built in MultiSens Analyzer. These algorithms have the 

striking advantage of being relatively intuitive and easy to use. There are only a limited number of 

parameters to "tweak", and the result is ready for immediate interpretation.  

Modern computers are fast enough to calculate most algorithms in very little time. MultiSens 

Analyzer makes good use of this property by invoking recalculations automatically as soon as any 

parameters have been modified or any data are added or removed. You never have to explicitly 

request a recalculation. There isn't even a command to achieve that. The program will recognize 

automatically what needs to be done. 

Normally you will want to start evaluation work flow by defining which measurements you want 

to include. Then, define a few basic parameters (definition of the feature vector). You will want 

to view the result immediately as a scores (scatter) plot. In addition you may want to open further 

windows containing the features matrix, a loadings plot, etc. 
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All these windows pertain to one single file though. They just show different views. Changes 

made in any one of these windows will immediately proliferate to all other windows. Hence, you 

will hopefully soon find this an inspiring environment that will encourage you to "play" with your 

data in many different ways. Furthermore it is possible to load several evaluations simultaneously 

and compare the different results. 

 

3.2.1.1 Reference data 

To start an evaluation you will need reference data. Those data that are used to construct the 

mathematical model on which the evaluation is based are called reference data - no reference 

data, no model. It is, however, possible to perform an evaluation with only reference data (i.e. 

without any independent test data) 

3.2.1.2 Adding Filters 

Filters in MultiSens Analyzer allow recalculating a complete response curve of a sensor. A 

common use for filters is to remove noise from a sensor response.  

Within MultiSens Analyzer a filter actually is implemented like an additional (virtual) sensor. It 

does not alter the response curve of a sensor. Rather a new (virtual) sensor is created that 

contains the filtered response curve. This new sensor can then be chosen as source for 

subsequent algorithms.  

One advantage of this approach is, that you can chain filter algorithms. After creating a Filter you 

can choose the output from this filter as source for a new filter. 

Another advantage is that you can create graphs that show filtered and unfiltered data from one 

sensor and thus compare the effectiveness of a filter algorithm. As all graphs are automatically 

updated whenever corresponding parameters change, you may even visually optimize filters by 

opening suitable graphs and changing the filter parameters. 

A list of filter algorithms is included in the appendix. 

3.2.1.3 The Feature extraction 

Theoretically it would be feasible to feed the raw sensor response curves into a regression or 

classification algorithm, with no prior treatment. However, the curves contain a very large 

amount of redundant information which would serve no other purpose than to blow up 

computation time unnecessarily. By extracting characteristic values (features) from the entire 

curve, a much reduced data set is obtained which (hope-fully) still retains most of the information 

present in the full curve and emphasizes the relevant information. This procedure is called feature 

extraction. 

As soon as the reference data set contains at least one measurement it is possible to define how 

to extract the feature vector from the individual sensors response curves. The feature vector thus 
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defines, which data goes into the subsequent classification or regression algorithm. You need to 

explicitly choose the algorithms and sensors to be used. 

After the feature vector is defined, the calculation does not need to be started manually. Again, 

the MultiSens Analyzer software will automatically invoke the required algorithms.  

The most popular feature is the one that determines by how much the sensor signal has changed 

during the exposition to the gaseous sample. In MultiSens Analyzer parlance, this feature is called 

Sig-Base, shorthand for Signal minus Baseline. This means that the largest positive or negative 

deviation (Signal) from the initial value (Baseline) is extracted. 

Features whose name ends in "3" use an additional averaging over three adjacent data points. 

Whether or not this averaging makes sense depends on the particular sensors and application. 

A list of feature extraction algorithms is included in the appendix. 

3.2.1.4 The principal component analysis (PCA) 

After feature extraction, each measurement will contribute one or several feature vectors. The 

feature vectors span a multi-dimensional space (feature space) where each measurement is 

represented by a point. The features are the base vectors for this space; if only one feature per 

sensor is extracted (e.g. Sig-Base), the feature space has as many dimensions as there are sensors. 

PCA tries to find new base vectors (which are linear combinations of the original base vectors) 

for feature space. Thus, drawing an analogy to our familiar three-dimensional space, PCA rotates 

the coordinate system. Obviously, a simple rotation of the coordinate system will not help a great 

deal in reducing the space's dimensionality. Actually, it will not help at all. 

The trick with PCA is that the new base vectors are chosen according to the variance of feature 

vectors. The first base vector will be chosen so that it represents the direction along which there 

is the largest variance; the second base vector will show the second largest variance, and so on. 

The base vectors thus found are then called principal components. The first principal component 

therefore points in the direction where the reference measurements show the greatest degree of 

variation. 

This method will only help if the variance of feature vectors is not sufficiently well represented by 

the original base vectors. This is the case when there is cross sensitivity between sensors, and 

when the sensors are not overly selective. 

The scores plot (scatter plot) shows data projected onto a plane which is spanned by two 

principal components. By default, the X axis is the first principal component while the Y axis 

corresponds to the second PC. As discussed previously, these two PCs represent the bulk of the 

variance present in the data set. The distance between samples corresponds directly to their 

degree of likeliness as "seen" by the sensors. 

The scores plot is a display technology to get similarities and differences of samples at a glance. 
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3.2.1.5 Classification of test data 

Frequently, the goal of an evaluation is the classification of an unknown sample, i.e. to determine 

the degree of similarity with known classes of previously analyzed samples. The MultiSens 

Analyzer software has built-in algorithms to classify an unknown new sample based on the class 

membersip of the reference data. To this end, the program obviously needs to be told which 

classes the individual reference data measurements belong to.  

One algorithm is to calculate distances of a new sample to the reference data, and select the class 

most frequently found in the k nearest neighbours, where k is a non-zero, user selectable integer 

number. This algorithm is also known as the KNN method (k-nearest-neighbours). 

Additionally to the classification by the KNN method it is possible to calculate the Mahalanobis 

distance. The Mahalanobis distance is a value which gives the dissimilarity of a sample in respect 

to a certain class. A value of 0 means the sample exactly matches the class. Large values are 

indicating a high dissimilarity to a given class. 

The computation of the Mahalanobis distance calculates the variation of samples within a class 

around its centre in respect to the distance of the new sample. Consequently the Mahalanobis 

distance takes the area of the reference data into consideration. To allow this calculation it is 

necessary to have enough reference data for a given class. The number of reference data points 

always has to be larger than the dimension of the vector space of the computation. If this doesnõt 

hold the program will give the output NaN (Not a Number). Since for practical reasons the 

number of reference data points is low it is useful to use the scores as input data for the 

Mahalanobis distance. The values for the Mahalanobis distance are displayed next to the sample 

description. Here all distances to all classes are shown giving the description of the class first 

followed by the Mahalanobis distance. Additionally to the sample values the Mahalanobis 

distance values for the centres of the classes will be displayed next to the class description. 

3.2.1.6 The linear discriminant analysis (LDA) 

LDA is an alternative method to calculate a new coordinate system for the representation of the 

measurements. In contrast to PCA where the coordinate axes are chosen to represent the 

maximum variation within the reference data, LDA will explicitly use information about the class 

memberships of the reference data to find a representation that maximizes the distances between 

data belonging to different classes and minimizes the distances between data belonging to the 

same class.  

The number of coordinate axes (equivalent to the scores of the PCA), that an LDA will generate, 

is determined by the number of different classes. 
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3.2.1.7 The principal component regression (PCR) 

Principal Component Regression is an extension of the Principal Component Analysis. During 

calibration for each sample a certain user defined or independently measured target value (e.g. a 

concentration value or a quality index) is assigned. 

As described before the principal components are calculated. Using these principal components a 

multi linear regression is subsequently performed with the user defined values as target data. 

Resulting regression coefficients used together with the Loading values of the PCA allows the 

prediction of unknown samples. 

3.2.1.8 The partial least squares algorithm (PLS) 

As an alternative to PCR, the PLS algorithm may be used. PLS takes the target values of the 

reference data into account when calculating the scores. It optimizes the regression from the 

features to the target values by choosing a scores projection that minimizes the regression error.  

3.2.2 The Classification 

3.2.2.1 The parameters 

An evaluation's parameters are collectively displayed on several pages within one window. Page 

one and two contain lists of reference and test data, used in the evaluation. The next page 

contains settings for the filters. Page four defines the feature vector. Page five contains general 

parameters and algorithm selection and the last page contains the settings for the classification. 

This series reflects the way the algorithms are calculated in sequence. After the definitions of the 

raw data sets (reference and test data) the filters add new virtual sensors. Then the feature vector 

extracts the relevant data which is then fed into the core algorithms. The output of this algorithm 

is then used to assign the class to unknown samples. 

3.2.2.1.1 Reference data 

On the Reference data page you will enter those measurements that are to be included in the 

calculation of the prediction model. When you click the Add button, a dialog window will open 

which allows you to open several measurement data files simultaneously by holding down the 

SHIFT or CTRL key while clicking on the files one by one, or by drawing a marquee around 

several files. In this window you may also change the directory clicking on it or using the symbol 

status line. 

Measurements can be removed altogether by highlighting the corresponding line and clicking 

Delete, or they can be changed from reference to test data by clicking -> Test data 

You may change the sequence of measurements by highlighting one line and then click-dragging 

it to a different place in the list. Most analysis algorithms are not affected by changes in the 

sequence; however it may help you with entering data or displaying suitable graphs. The sequence 
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can also be sorted automatically. Right clicking in the list brings up a menu which gives you a 

number of choices.  

By clicking Show, windows with the measurement parameters for all selected measurements in 

the list are opened. 

By clicking Plot, plots for all selected measurements in the list are opened. The same result can 

be achieved by double clicking a measurement's file name in the table. 

If you want to be able to have newly added test data automatically attributed to a certain class of 

samples, you will need to first define classes of reference data. To do this, highlight all reference 

measurements belonging to a certain class, and fill in a descriptive class name in the Class field. 

Alternatively you can press the Sam.->Class button, which will copy the contents of the column 

Sample to the column Class. 

 

Column Description 

No Number of the measurement. 

Measurement Name of the measurement. 

Sample Sample that was measured. 

Date Date and time when the measurement was taken. 

Class Class the measurement belongs to. 

Tip: You can change the sequence of measurements by highlighting one line and then click-dragging it 

to a different place in the list.  

Tip: Right clicking in the list will bring up a popup menu. In this menu you can sort the list by 

Measurement / Sample / Date or class. You can also copy the Measurement name or sample to the 

class. You can also add the Date to the Class, which will effectively split the class into separate 

classes for each day. 
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3.2.2.1.2 Test data 

On the Test data page you can enter those measurements that you want to process according to 

the previously built model (in other words, adding more test data will not change an existing 

model). All buttons work in analogy to their Reference data counterparts. However, a class 

cannot be entered. If no classification has been selected on the Classification page (see below 

for details), or if no classes have been defined for the reference data, a question mark will appear 

in the Class column. Otherwise, the class determined by the classification algorithm will appear 

here. 

 

Column Description 

No Number of the measurement. 

Measurement Name of the measurement. 

Sample Sample that was measured. 

Date Date and time when the measurement was taken. 

Class Class the measurement belongs to. 

3.2.2.1.3 Filters 

Filters calculate a new response curve based on the response curve of sensors. Using filters is 

optional (the Basic edition of MultiSens Analyzer does not contain filters). 

New filters can be introduced using the Add button. Once you have clicked Add you will first 

need to choose the device(s) from which you want to create new filters. Finally, select the desired 

type of filter. Depending on the filter type a window requiring extra user input may show up.  


